3e année

Mission 1

Octobre

Si=

Y -

Mission 2
Novembre

(S

5Gannée

Mission 3
Décembre

MisSion FoSS

an

Mission 4
Janvier

/A

Mission 5
Février

Mission 7
Avril

ible ¢n TIC

Agents secrets, 3 vos écrans!

L'automne animé
Flip Boom [/

Réaliser un dessin
animeé sur le theme de
I'automne (feuilles ou
pommes qui tombent
de l'arbre).

Un courriel pour mon
enseignante

Rédiger un message
pour son enseignante
(theme déterminé par
I'enseignante).

Pére-Noél s'amuse
avec le bingo sonore!

Publisher [} ou
PowerPoint |V

+
Audacity |

A l'aide du jeu de
bingo, chaque éléeve
rédige un « Qui suis-
je? » afin de faire
deviner un des mots.
lllustrer le mot puis
enregistrer la
devinette.

Jouer au bingo sonore
en classe.

Un athléte de qualité
www.babygo.fr
Effectuer une recherche
sur un athléte avec
Iintention de relever
les qualités requises
pour exercer sa
discipline ou son sport.

Scrapbook amical
PowerPoint [V

Se prendre en photo
avec un ami. Réaliser,
en dyade, une
présentation de type
Scrapbooking digital.

Une recette farfelue!
Publisher [} ou

Pages
Word [/

Inventer une recette
farfelue du type « A /a
sauce vieux pneu! »,

ou

Mon domaine
LopArt [} ou

Paint [} ou
Paintbrush

Dessiner, de mémoire,
ce que je voyais a
I'entrée de ma chambre
ce matin.

Imprimer et apporter a
la maison pour
comparer.

La sécurité, c'est
sérieux!

Comic Life |V ?

En équipe, les éleves
choisissent une
situation sur la sécunté
des enfants a |'école et
réalisent un
photoroman a l'aide de
4 photos prises par
eux-memes.
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Nouveau document:
Y Flip BoorAll-Star 1.0 - Sans ng
............................. Fichier Ewn Affich Lecture Outils Bibliothéque Aide

Couleur de
remplissage des
zones fermées

Importer une
image ou une
photo

Ajouter ou
supprimer une

L'interface de FlipBoom All Star

Ouvrir un :
. document existant :

%Afﬂcher le fantémeg

Propriétés des
outils de dessin

.

FTOH O

Visionner
I'animation

Vitesse de
I'animation

- s
Propriété:

Taille Maximale 20

Lissage

A 3

CEOK X EORA m

N N NN
..‘k)..:mx

Bibliothéque
+ -- Animals
-- Avatars
: Backgrounds
Bubbles
+ -- Characters
+ -- Creatures

+ -- Genie
+ -- Props
Shapes

+-([8]) Accessories

B

Copier la page
sélectionnée

Mission possible en TIC e Julie Aubé et Suzanne Harvey « RECIT de la CSDC

. Sélectionner une
couleur dans
§|| de dessin :
‘ 'espace de dessin :

Choisir une couleur:
dans le cercle
chromatique

\ Bibliothéque

d'images
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Pére-Noél s'amuse au bingo!

emballage cadeau étoile
calendrier renne cloche
dinde sapin guirlande

Pére-Noél s'amuse au bingo!

réveillon cadeau boule
emballage réveillon Neige
dinde rouge guirlande

Mission possiol
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Pére-Noél s'amuse au bingo!

ruban cadeau boule
Mére-Noél renne cloche
dinde sapin traineau

Pére-Noél s'amuse au bingo!

réveillon cadeau boule

tourtiére Pére-Noél Neige

ruban rouge guirlande

Mission possible en TIC « Suzanne Harvey et Julie Aubé « RECIT CSDC




Pére-Noél s'amuse au bingo!

emballage cadeau Neige
Mére-Noél renne cloche
dinde réveillon guirlande

Pére-Noél s'amuse au bingo!

rouge cadeau étoile
tourtiére réveillon Neige
dinde sapin guirlande

VIISSION POSSI
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Pére-Noél s'amuse au bingo!

grand-papa cadeau Neige
Mére-Noél renne cloche
dinde réveillon traineau

Pére-Noél s'amuse au bingo!

rouge ange boule

Pére-Noél réveillon emballage

dinde Mére-Noél guirlande
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Pére-Noél s'amuse au bingo!

grand-papa cadeau Neige
Pére-Noél ange cloche
guirlande réveillon traineau

Pére-Noél s'amuse au bingo!

rouge renne boule

calendrier réveillon grand-papa

dinde rouge traineau

VIISSION POSSI en 1« suzZanne Rarvey et Julie Aupe * HEbI IAY25] Piw3




Pére-Noél s'amuse au bingo!

bougie cadeau Neige
tourtiére ange cloche
guirlande calendrier traineau

Pére-Noél s'amuse au bingo!

rouge décembre étoile
tourtiére réveillon bougie
dinde rouge janvier

Mission possible en TIC « Suzanne Harvey et Julie Aubé « RECIT CSDC




Pére-Noél s'amuse au bingo!

janvier cadeau Neige
tourtiére ange cloche
guirlande dinde traineau

Pére-Noél s'amuse au bingo!

rouge décembre boule
tourtiére ruban Pére-Noél
dinde grand-papa janvier

Mission possible en TIC + Suzanne Harvey et Julie Aubé «+ RECIT CSDC




Pére-Noél s'amuse au bingo!

décembre ruban Neige
tourtiére ange cloche
guirlande dinde bougie

Pére-Noél s'amuse au bingo!

Pére-Noél décembre boule
tourtiére ruban lutin
dinde rouge cloche

Mission possible en TIC « Suzanne Harvey et Julie Aubé « RECIT CSDC




Pére-Noél s'amuse au bingo!

grand-papa ruban Neige
tourtiére ange cloche
guirlande boule bougie

Pére-Noél s'amuse au bingo!

grand-papa | guirlande boule
tourtiére ruban lutin
traineau rouge janvier

Mission possible en TIC « Suzanne Harvey et Julie Aubé « RECIT CSDC




Pére-Noél s'amuse au bingo!

renne ruban Neige
tourtiére ange emballage
guirlande boule bougie

Pére-Noél s'amuse au bingo!

grand-papa | guirlande boule
tourtiére réveillon lutin
traineau rouge décembre

Mission possiol
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Pére-Noél s'amuse au bingo!

renne ruban calendrier
tourtiére ange emballage
lutin boule bougie

Pére-Noél s'amuse au bingo!

grand-papa | guirlande boule
dinde réveillon lutin
traineau rouge grand-papa

Mission possible en TIC + Suzanne Harvey et Julie Aubé «+ RECIT CSDC




2

4

Enregistrement a I'aide d'un microphone

Réglez le volume d’enregistrement.

& .

Faites un essai pour vérifier les niveaux.

5 Cliquez sur le bouton Enregistrer et captez
quelques secondes de son.

N Cliquez sur le bouton Arrét pour stopper

I'enregistrement.

Trop fort

Supprimez la piste d’essai.

Enregistrez tout le texte d'un personnage, puis cliquez sur arrét. Prendre soin de laisser un
peu de silence AVANT et APRES chaque réplique.

Enregistrez autant de pistes qu'il y a de personnages. Nommez chaque piste pour vous
aider a faire votre montage.

Enregistrez le résultat: Fichier => Enregistrer sous.

;4— MH
Trop faible Correct !

X|ristert  w| 1,0]

3
3
h

Déplacer la piste vers e bas

Faorme d'onde (dE)
Spectre
Hauteur (EAC)

ATTENTION: Il y a aura un dossier (_data) de créé ainsi que deux fichiers (.aup et .bak). Si vous voulez déplacer votre

enregistrement, vous devez déEIacer ensemble le dossier ainsi gue les deux fichiers.

© Karine St-Georges
Cs des Chénes 2009



Exporter le montage en format wav ou en format mp3

Edition  Affichage Projet Generer  Effet Pour exploiter votre montage dans un autre logiciel, vous devez I'exporter
Mowrveau Chrl+H dans un format universel.
Ouwrir,.,, k40
Fermer CEEH

Enregistrer le projet sous. ..

Praojets récents, ., »

Exporter an WAY. ., < Le format wav offre la meilleure qualité sonore mais occupe beaucoup de
place sur le disque dur.

Expatter comme MP3... Le format mp3 offre une qualité sonore acceptable et divise environ par 10
I'espace nécessaire sur le disque dur. Le mp3 est le format standard d'Internet.

Exporter comme Cgg Yorbis Le format Ogg Vorbis est un format libre. Il offre une qualité sonore légére-
ment supérieure au mp3 tout en occupant un peu moins d’espace. Il faut un
logiciel spécialisé pour lire ces fichiers, mais ce logiciel est gratuit.

Export Multiple... Si vous désirez télécharger Audacity, vous pouvez aller a I'adresse suivante:
T http://audacity.sourceforge.net/
Imprimer...

Pour exporter en mp3, vous devez installer un utilitaire nommé
Quikker LAME MP3 ENCODER. Il est possible de télécharger I'utilitaire au méme en-
: : : droit que le logiciel

NG Choisir un emplacement pour le fichier,
donner un nom au fichier et enregistrer.

Dang le fichier erpaorté, vos pistes seront mélangées en deus canaux stéréa

[ Me plus montrer cet avertizeement,

0K

Cli N
CIQUCZ SUTUIN,

© Karine St-Georges 11
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Effectuer une mise en page avec Publisher

recit

1. Ouvre Publisher

Insére le titre

D Gien Whaoe Pennon Pam Ooh Dty Dapagion Ay of piipenage |

DCse e BY N NG S™ =0 O

le 00/ BRE

o

Ecris verticalement

Italique -

- |5 IX

i1d (Composition nom encogittrde) - Microsolt Publishee

Gras

[= Teste bt (A e ] (] 7Ee[<hd] [¥] [E[C] [s[Q]s Donne une bordure
F DT L T TR O T TN - ” f 4R W FTe LT | TR TR _‘Mlh B a1 e I ek b =

Pteer Cdtion #

Donne une fome || Choisis 1a Ajusterle tize Ajoute une ombre
speciale 2 ton police de Votre texie wi

caracteres

titre. Colore ou donne une

trame aux lettres

ncdow s symbcle | Moo & Faichage | Applique une rotation

1
'i_:
1
"
=
d
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Insere du texte

Bwr (on WO Jewton Fame Ok Tbieas Owpeglion fyuson o pilpotage |
DS & ' "B Y o L% 4Ee ™ =0

e 007 BR X

Grosseur du caractere

T Smos | Outlinn a0
T Smple Indust Shaded 10
¥ Smpie Otiine Pat sesia-ges

00/ R X O> ~
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Insére une image clipart

id (Compesition son enregittrée) - Micresoft Publisher

Ecver Edtion Yfichage Jroertion Format Quils Tabless Dspogtion Fysion et publpostage T
D@ ST~ QR OG T o =+ 03
dZ= "gaadg

premier icone (inserer)

mei‘-h B 1o s La bibbot? - »

U, 3 amu Oocunm 004-

Riachasches les clos - [T a0ns um cu dhumnes ots
2] e | G Som |0 Clon s |

.ﬂ-l.ufml-uB.h&-l'.-ﬂmh-ﬂuhnfmhu la-ll?lln-'=lunn‘ulmlmnh&n-ﬁ-h-ﬁ"uﬁ-|m|l-ulal-mdllﬁﬂugnhumlhuminmlnﬁnhlmd-ul:

Inscns le nom de I'image que tu veux.
Clique sur I'image et sélectionne le

~
e @00/ BEH %X A> o

O < PO DO T T iy BTN O T SO Y |

& Viens faire
ton encadré : .

= —

n-llhh

~
o

ln“l.jnl..

~.

T amvaees o)

§_
J
-

A% $000 om
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BabyGo

recit

1. Ouvre

www.babygo.fr

+ Google v | *§ rechercher -

le Moteur de Recherche des Enfants

Web Images Jeux Coloriages Livres

Rechercher

| Francgais uniguement d Définition et Synonymes

é Conjugaison Mathématiques el Besoin d’aide ?
CC)

5. Choisis le site le plus approprié.

| Resultats Web Résu

| Ananas - Vikidia, I'encyclopédie pour enfants Par
Ananas .« Ananas » expliqué par Vikidia, fencyclopédie pour les enfants. Aller a : Navigation,

s Rechercher Des ananas .Un ananas est un ;frul, originaire de rAmérique d

httpu/ifr.vikidia.orglindex.php/Ananas - en cache

Ananas : explication Téte a modeler du mot ananas activite \

Ananas : Mot du glossaire Téte 4 modeler. Un ananas porte un fruit exotique & écorce épaisse et &

chair jaune. Activités associées

Ananas Nom masculin : on dit un ananas - des ananas Ananas : Un ananas perte un fruit

exolique & écorce épaisse ef a chair jaune. .L'ananas est une plante herbacée origin

http://teteamodeler.com/glossaire/mots/glos-a/ananas.asp - en cache  Voir toutes les
réponses de
teteamodeler.com

ing
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SCRAPBOOKING DIGITAL

AAAAA Avec PowerPoint

DES CHENES

1. Insérez le disque dans le lecteur et ouvrez une nouvelle présentation
(vide) PowerPoint

2. Enregistrez

3. Insérez un arriére-plan

Format > Arriére-plan...
Cliquez sur la fleche v | et sélectionnez Motifs et textures...

Onglet Image > Bouton Sélectionner une image...
Choisissez l'arriere-plan de votre choix
* Regarder dans : (cliquez sur la fleche et choisissez le disque)
» Choisissez votre theme
e Choisissez un papier (double-cliquez)
* OK
* Appliquer

4. Insérez les éléments décoratifs

Insertion

Image > A partir du fichier...

Choisissez I'image (double-cliquez)

Jouez avec lI'image (redimensionnement, rotation, etc.)
Répétez ces étapes jusqu’a ce que la page soit a votre go(t

5. Insérez des photos ou d’autres images

Assurez-vous que la barre d’outils image soit accessible
Clic droit sur I'image pour changer l‘ordre

Lorsque le montage est a votre go(t, groupez les éléments (plus facile
pour le déplacement, surtout lorsque I'on utilise des lettres).
On peut les dissocier au besoin.

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) * février 2011



6. Pour écrire du texte

Insertion > Zone de texte

Ecrivez et mettez en forme le texte (police, couleur, grosseur, etc.)
Placez la zone de texte a I’endroit voulu

Jouez avec le bloc de texte (rotation, plans, etc.)

Petits extras

1. Pour changer le format des diapositives :

Fichier > Mise en page...

Cliquez sur la fleche \ V‘ et sélectionnez Personnalisé

Ex : 30 cm X 30 cm

2. Pour faire une image de votre diapositive :

Sur la diapositive : Fichier > Enregistrer sous...
Enregistrer dans : (D ou X)

Nom de fichier :

Type de fichier > JPEG ou GIF

Diapositive en cours uniquement

*x* N'oubliez pas d’enregistrer votre travail **x*

Amusez-vous!

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) ¢ février 2011
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IRE
DES CH E.NFS

LopArt

Logiciel d'arts plastiques et
de communautique

gl o e ok L T S A T S e S

Petit guide abrégé



Les outils du portfolio

@@

Canevas Informations
L J" — .
f 3

J Carte
Diaporama Musée postale

EX=,

Exportation Impression Recyclage

Astuces
‘z Pour transférer une image d’'un portfolio LopArt a un autre, appluyez sur la O3 ]1
touche majuscule avant d’appuyer sur I'icbne d’exportation. L ,J

£ Pour récupérer son dessin en format .lop, cliquez sur la majuscule puis sur la page blanche.

‘z Pour démarquer un détail ou une forme, dessiner la ligne contour apres le dessin, pour éviter de dépasser lors du
remplissage.

Suzanne Harvey - RECIT de la Commission scolaire des Chénes Page 2



Les outils de dessin du canevas

Annuler ou vijtesse
Couleurs Duo-tons Textures rétablir d’animation

l Transparence \

v

5
L
@
Niveaux de Trait Taille Animation
textures
Les textures
Niveau 1 Niveau 2
1)(2)(3)(4 1)(2)(3)(4 .
1. Gouache 7 W 1. Ecailles
I ; 2. Aquarell¢ i l‘ a'.g-_ ¥ III.f 2. Taches
3. Aérosol gt 3. Eau
e \
i 4. Cire - éq\; _ 4.
| 5. Fusain ¥ “},.e . Branches/Foin
6. Encre Ny gh Ml 5. cheveux
7. Cire : 6. Feuilles
5 6 7 8 8. Pastel 5 6 7 8 7. Ifrisous
o CAAv~A

. Ecorce

. Etoiles

. Pétales/Cercles
. Ecorce

. Guirlande

. Feuilles

elouse/Fourrure

Suzanne Harvey - RECIT de la Commission scolaire des Chénes Page 3



Les couleurs et les duo-tons

Tons de gris Couleurs Duo-tons

rw A oy

Couleur Goutte d’eau pour
sélectionnée I'estompage

% Astuce : Pour retrouver une couleur, cliquez sur celle-ci dans le canevas (sur le dessin) en enfongant la touche
majuscule. Ainsi, tous les parameétres précédemment établis se réaffichent.

Suzanne Harvey - RECIT de la Commission scolaire des Chénes Page 4



.t
rb COMMISSION SOILARE
PES CHENES

Réaliser un photoroman

Avec ComicLife

Suzanne Harvey
Service local du RECIT
Commission scolaire des Chénes

recit.csdc.qc.ca Février 2009




Etape 1 : batis un Scénario

Réalisation d’un photoroman avec Comic Life e RECIT de la CSDC e Suzanne Harvey -

page 2




Etape 2 - Réalise la bande dessinée

——— — — . — - e ——————

@ Démarre Comic Life

@ Choisis un modele de page. Clique dessus et glisse-le jusque dans la page.

SN

2 o= @ & 0o&

brregsrer Bngrimer Cowder  Zeom evasl oameribie Adapier

Gt BEMT Wak FRgR FamML AN Kde

Cherche ton dossier de photos. QOuvre-le.

i3 PAIATEE TU - T =T =TT,

bas. ] l
Er wailal

Réalisation d’un photoroman avec Comic Life e RECIT de la CSDC » Suzanne Harvey - page 3




Glisse les photos dans les panneaux.

L e a2 e, LS

| Barwpaten bugeear S Toom ovast Zosem srviben daphr Trwmens sive_irivive tis

T“‘ OO0 S
Gy s 2000 08200 o ||| mom e

il

&« @ =

Enregistrer Imprimer

Réalisation d’un photoroman avec Comic Life e RECIT de la CSDC e Suzanne Harvey - page 4




